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Chapter 2
Parametric Modeling Fundamentals

Learning Objectives

¢ Create Simple Extruded Solid Models

¢ Understand the Basic Parametric
Modeling Procedure

¢ Create 2D Sketches

¢ Understand the “Shape before Size”
Design Approach

¢ Use the Dynamic Viewing Commands

¢ Create and Edit Parametric Dimensions
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Introduction

The feature-based parametric modeling technique enables the designer to incorporate
the original design intent into the construction of the model. The word parametric means
the geometric definitions of the design, such as dimensions, can be varied at any time in
the design process. Parametric modeling is accomplished by identifying and creating the
key features of the design with the aid of computer software. The design variables,
described in the sketches as parametric relations, can then be used to quickly
modify/update the design.

In Autodesk Fusion 360, the parametric part modeling process involves the following
steps:

1. Create a rough two-dimensional sketch of the basic shape of the base feature
of the design.

2. Apply/modify constraints and dimensions to the two-dimensional sketch.

3. Extrude, revolve, or sweep the parametric two-dimensional sketch to create
the base solid feature of the design.

4. Add additional parametric features by identifying feature relations and
complete the design.

5. Perform analyses on the computer model and refine the design as needed.
6. Create the desired drawing views to document the design.

The approach of creating two-dimensional sketches of the three-dimensional features is
an effective way to construct solid models. Many designs are in fact the same shape in
one direction. Computer input and output devices we use today are largely two-
dimensional in nature, which makes this modeling technique quite practical. This method
also conforms to the design process that helps the designer with conceptual design along
with the capability to capture the design intent. Most engineers and designers can relate
to the experience of making rough sketches on restaurant napkins to convey conceptual
design ideas. Autodesk Fusion 360 provides many powerful modeling and design-tools,
and there are many different approaches to accomplishing modeling tasks. The basic
principle of feature-based modeling is to build models by adding simple features one at
a time. In this chapter, the general parametric part modeling procedure is illustrated; a
very simple solid model with extruded features is used to introduce the Autodesk Fusion
360 user interface. The display viewing functions and the basic two-dimensional
sketching tools are also demonstrated.
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The Adjuster Design

Starting Autodesk Fusion 360

1. Select the Autodesk Fusion 360 option on the Start menu or select the
Autodesk Fusion 360 icon on the desktop to start Autodesk Fusion 360. The
Autodesk Fusion 360 /og in window will appear on the screen.

4 Butodesk

W' 1230 Design
[m Autodesk Design Review 2013 Contrel P
F oa usion 360
' Meshmi Devices ai
U Uninstall 123D Design
B Uninstall Meshmixer Default Pr

4 Help and

| Search programs and files

Signin A

Email or Username

2. Inthe Sign In dialog box, log in
with your email or username.

MNEW TO AUTODESK? CREATE ACCOUNT
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The Autodesk Fusion 360 Screen Layout

The default Autodesk Fusion 360 drawing screen contains the Quick access toolbar, the
Modeling toolbar, the Navigation toolbar, the Model Browser, the drawing area, and the
View Cube. You may resize the Autodesk Fusion 360 drawing window by clicking and

dragging the edges of the window, or relocate the window by clicking and dragging the
window title area.

Workspace

Quick Access Toolbar
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<« BROWSER el Z%TW/LX
PN @ (Unsaved) [O

[> 48 Document Setiings .

D EJ vamsavens Modeling Toolbar

D @ E1 origin

\ View Cube

Model Browser )
Graphics
Window
/ Display Control Panel
COMMENTS o P ™ Q- O E-m\-
TRAEER @
'Y

N

F Autodesk Fusion 360 (Education License)

» Autodesk Fusion 360 is an
I @ untitied % - integrated system that can be used
1 . to create parts, assembly,
m - H &~ animation, simulation, CAM and
2D drawings. By default, the

MODEL ~ @ ._D Q gT 6 Model WorkSpace is activated as

shown.

Timeline Control Panel

Ik SKETCH ™ CREATH
4 BROWSER Change Workspace ° I

FIR*R @ (unsavea) fO

[ {# Document Settings
[ ] NamedViews

> & B3 origin
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Units Setup

+»+ Every object we construct in a CAD system is measured in units. We should
determine the value of the units within the CAD system before creating the first
geometric entities. For example, in one model, a unit might equal one millimeter of
the real-world object; in another model, a unit might equal an inch. In Autodesk
Fusion 360, the Document Settings option can be used to quickly display and also
switch to using a different units set.

F Autodesk Fusion 360 (Education License)
B OE- H -~

SKETCH ™

44 BROWSER

VIR @ (unsavea) [O]
%& Document Settings
Q Units: mm
[» F7 Hamed Views

> @ B3 orign

1. Click on the triangle icon next to the
W untitled X . L
Document Settings option in the Browser

area to show the default units as shown.
Note the current units is set to the millimeter

MODEL ~ @ ) gI (mm) units as shown.

CREA
el

2. Click on the Change
Active Units option in the
Browser area as shown.
We will use the inch (in)
units for this example.

MODEL * @ -—D g gI @

SKETCH ™ CREATE ™ i
+1 BROWSER @ |

4 Q [IUERTE®

A ﬁ Document Settings

ll;jl I % Change Active Units

[> ] wHamedViews
D @ F3 oOrigin

@ CHANGE ACTNE UNITS

Centimeter
v Millimeter
Meter

e

Foot

Unit Type Millimeter *

3. Inthe Units list, select Inch as shown.

4. Pick OK to exit the Change Active Units
dialog box.

ancel
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Sketch Plane - It is an XY monitor, but an XYZ World

Design modeling software is becoming more
powerful and user friendly, yet the system still
g does only what the user tells it to do. When

T using a geometric modeler, we therefore need
to have a good understanding of what its
inherent limitations are.

—
-
-

In most 3D geometric modelers, 3D objects
are located and defined in what is usually
called world space or global space. Although
a number of different coordinate systems can
be used to create and manipulate objects in a
3D modeling system, the objects are typically
. _ ; defined and stored using the world space. The
Ly ' world space is usually a 3D Cartesian
T ' coordinate system that the user cannot change
or manipulate.
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In engineering designs, models can be very complex, and it would be tedious and
confusing if only the world coordinate system were available. Practical 3D modeling
systems allow the user to define Local Coordinate Systems (L.CS) or User Coordinate
Systems (UCS) relative to the world coordinate system. Once a local coordinate system
is defined, we can then create geometry in terms of this more convenient system.

Although objects are created and stored in 3D space coordinates, most of the geometric
entities can be referenced using 2D Cartesian coordinate systems. Typical input devices
such as a mouse or digitizer are two-dimensional by nature; the movement of the input
device is interpreted by the system in a planar sense. The same limitation is true of
common output devices, such as CRT displays and plotters. The modeling software
performs a series of three-dimensional to two-dimensional transformations to correctly
project 3D objects onto the 2D display plane.

The Autodesk Fusion 360 sketching plane is a special construction approach that enables
the planar nature of the 2D input devices to be directly mapped into the 3D coordinate
system. The sketching plane 1s a local coordinate system that can be aligned to an
existing face of a part, or a reference plane.

Think of the sketching plane as the surface on which we can sketch the 2D sections of the
parts. It is similar to a piece of paper, a white board, or a chalkboard that can be attached
to any planar surface. The first sketch we create is usually drawn on one of the
established datum planes. Subsequent sketches/features can then be created on sketching
planes that are aligned to existing planar faces of the solid part or datum planes.
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F Autodesk Fusion 360 (Education License)

@ untitied X

B OB g e - 1. Activate the Create Sketch icon

with a single click of the left-mouse-

MODEL ~ % -—D (] g] @ G I button.

SKETCH ™ CREATE™ MODIFY =

+4 BROWSER Create Sketch

4

Enters Sketch mode and creates a new sketchon a
selected plane or face.

Select Finish Sketch to exit out of the mode.

@ [
D &
|

2. Move the cursor over the right vertical plane, the XY Plane, in the graphics area.
When the XY Plane is highlighted, click once with the left-mouse-button to
select the Plane as the sketching plane for the new sketch.

o The sketching plane is a reference location where two-dimensional sketches are
created. Note that the sketching plane can be any planar part surface or datum
plane.

£ Autodesk Fusion 360 (Education License) 3. Click and press on the Sketch tab in the main
Ribbon area to display the available sketching
tools as shown. Also note the Sketch Palette

panel is also activated with additional

@ untitlea* x
OB H ~ -

MODEL ~ @ 0 B @] é sketching options.

WE’M—E I| @ SKETCH PALETTE 9
+ BROWSER |_t‘3. Create Sketch i
4 Q [IT-D tne ] ™ Options
D #F Docum Rectangle 4 Construction <
D F] Named Circle » Look At
Arc »
g 3 g z Polygon 3 1 Sketch Grid (4]
3> Flinse cran >
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Creating Rough Sketches

Quite often during the early design stage, the shape of a design may not have any precise
dimensions. Most conventional CAD systems require the user to input the precise lengths
and locations of all geometric entities defining the design, which are not available during
the early design stage. With parametric modeling, we can use the computer to elaborate
and formulate the design idea further during the initial design stage. With Autodesk
Fusion 360, we can use the computer as an electronic sketchpad to help us concentrate on
the formulation of forms and shapes for the design. This approach is the main advantage
of parametric modeling over conventional solid-modeling techniques.

As the name implies, a rough sketch is not precise at all. When sketching, we simply
sketch the geometry so that it closely resembles the desired shape. Precise scale or
lengths are not needed. Autodesk Fusion 360 provides many tools to assist us in
finalizing sketches. For example, geometric entities such as horizontal and vertical lines
are set automatically. However, if the rough sketches are poor, it will require much more
work to generate the desired parametric sketches. Here are some general guidelines for
creating sketches in Autodesk Fusion 360:

e Create a sketch that is proportional to the desired shape. Concentrate on the
shapes and forms of the design.

o Keep the sketches simple. Leave out small geometry features such as fillets, rounds
and chamfers. They can easily be placed using the Fillet and Chamfer commands
after the parametric sketches have been established.

o Exaggerate the geometric features of the desired shape. For example, if the
desired angle is 85 degrees, create an angle that is 50 or 60 degrees. Otherwise,
Autodesk Fusion 360 might assume the intended angle to be a 90-degree angle.

e Draw the geometry so that it does not overlap. The geometry should eventually
form a closed region. Self-intersecting geometry shapes are not allowed.

e The sketched geometric entities should form a closed region. To create a solid
feature, such as an extruded solid, a closed region is required so that the extruded
solid forms a 3D volume.

» Note: The concepts and principles involved in parametric modeling are very
different, and sometimes they are totally opposite, to those of conventional computer
aided drafting. In order to understand and fully utilize Autodesk Fusion 360’s
functionality, it will be helpful to take a Zen approach to learning the topics presented
in this text: Have an open mind and temporarily forget your experiences using
conventional Computer Aided Drafting systems.
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Step 1: Creating a Rough Sketch

The Sketch toolbar provides tools for creating the basic geometry that can be used to

create features and parts.

F Autodesk Fusion 360 (Education License)

B OE- H - -
MODEL =

44 BROWSER

U or=mwa @

MODIFY ~

4 ¢ [ B
D £ Docum  Rectang
D EI Named Circle
DQFE o °
D QB s

Pohygon
Er Elipse

Slot

Spline

f*ﬁ Conic Curve

m_c\:smv
Create Sketch Ii

Creates lines and arcs.

Select a start and endp)
Click and drag the endp
an arc.

Graphics Cursors

Move the graphics cursor to
the Line icon in the Sketch
toolbar. A Help-tip box
appears next to the cursor
and a brief description of the
command is displayed at the
bottom of the drawing
screen: “Creates lines and
arcs.”

Select the icon by clicking
once with the left-mouse-
button; this will activate the
Line command. Autodesk
Fusion 360 expects us to
identify the starting location
of a straight line.

Notice a crosshair cursor is shown when graphical input is expected.

1. Left-click a starting point for the shape, roughly just below the center of the

graphics window.

2. As you move the graphics cursor, you will see a digital readout next to the cursor
and also in the Status Bar area at the bottom of the window. The readout gives
you the cursor location, the line length, and the angle of the line measured from
horizontal. Move the cursor around and you will notice different symbols appear

at different locations.

mEa

- 17.2 deq Spedfy next paint
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3. Move the graphics cursor toward the right side of the graphics window and create
a horizontal line as shown below (Point 2). Notice the geometric constraint
symbol, a short horizontal line indicating the geometric property, is displayed.

Constraint
Q@ Symbol
Point 1 \ n.o'deg/ Point 2
R
| Specify next peint

Geometric Constraint Symbols

Autodesk Fusion 360 displays different visual clues, or symbols, to show you alignments,
perpendicularities, tangencies, etc. These constraints are used to capture the design intent
by creating constraints where they are recognized. Autodesk Fusion 360 displays the
governing geometric rules as models are built. To prevent constraints from forming, hold
down the [Ctrl] key while creating an individual sketch curve. For example, while
sketching line segments with the Line command, endpoints are joined with a Coincident
constraint, but when the [Ctrl] key is pressed and held, the inferred constraint will not be
created.

| k Vertical indicates a line is vertical
— Horizontal indicates a line is horizontal
—_— Dashed line indicates the alignment is to the center point or

endpoint of an entity

\\ Parallel indicates a line is parallel to other entities

< Perpendicular indicates a line is perpendicular to other entities
Iﬁl Coincident indicates the cursor is at the endpoint of an entity
Concentric indicates the cursor is at the center of an entity
O

Tangent indicates the cursor is at tangency points to curves
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1. Complete the sketch as shown below, creating a closed region ending at the
starting point (Point 1). Do not be overly concerned with the actual size of the
sketch. Note that all line segments are sketched horizontally or vertically.

Point6 [ 7
< e Point 5
Point 4
/ / Point 3
| <
\ Point 1 \ Point 2

.o} Repeat Line |

Delete [:;‘ |
Cancel x |

+
Move/Copy +o0b |

Sketch |

=

[C* Press Pull

Hole [

2. Inside the graphics window, click once
with the right-mouse-button to
display the option menu. Select [OK]
in the pop-up menu, or hit the [Esc]
key once to end the Sketch Line
command.

Step 2: Apply/Modify Constraints and Dimensions

As the sketch is made, Autodesk Fusion 360 automatically applies some of the geometric
constraints (such as horizontal, parallel, and perpendicular) to the sketched geometry. We
can continue to modify the geometry, apply additional constraints, and/or define the size
of the existing geometry. In this example, we will illustrate adding dimensions to
describe the sketched entities.

I:JEEJ Circular Pattern
E:E Rectangular Pattern

Project / Include [ ]

Msmmnmh[mm D J

£ Stop SketchA

Create sketch dimensions
Use dimensions to control
sketch objects.

Select the sketch curves ti
area to position the dimen

1.

In the sketch toolbar, select the
Sketch Dimension command
as shown. The Sketch
Dimension command is
generally known as Smart
Dimensioning in parametric
modeling.
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2. The message “Select Geometry to Dimension” is displayed in the Status Bar area
at the bottom of the Fusion 360 window. Select the bottom horizontal line by left-
clicking once on the line.

F
%

line as the geometry to
dimension.

2. Pick the bottom horizontal

3. Pick a location below

the line to place the
/ dimension.

[select additional sketch geometry or location for dimension

3. Move the graphics cursor below the selected line and left-click to place the
dimension. (Note that the value displayed on your screen might be different than
what is shown in the figure above.)

4. Accept the default value by hitting the Enter key once.

% The Sketch Dimension command will create a length

dimension if a single line is selected.

in the figure.

[ Select sketch objects to dimension |

5. Select the top-horizontal line as shown

PN |

6. Select the bottom-horizontal line as
the second entity to dimension as

shown.

L T
i3

|

Ny

[ Select ske

tch abie

2.30
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7. Pick a location to the left of the sketch to place the dimension.

Z5k €
)

2.30

8. Accept the default value by hitting the Enter key once.

% When two parallel lines are selected, the Sketch Dimension command will create a
dimension measuring the distance between them.

9. On your own, repeat the above steps and create additional dimensions (accepting
the default values created by Fusion 360) so that the sketch appears as shown. Hit
the [ESC] key once to end the Dimension command before proceeding to the next

page.

0.70

ZSL'E

N

8041
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Dynamic Viewing Functions — Zoom and Pan

Autodesk Fusion 360 provides a special user interface called Dynamic Viewing that
enables convenient viewing of the entities in the graphics window.

1. Click on the Zoom Window icon located in the Navigation bar as shown.

+-av el B8 S8

@, Fit

Q Zoom Yindow

F&

2. Move the cursor near the center of the graphics window.

3. Inside the graphics window, press and hold down the left-mouse-button, then
move downward to enlarge the current display scale factor.

4. Press the [Esc] key once to exit the Zoom command.

5. Click on the Pan icon located next to the Zoom command in the Navigation bar.

The icon is the picture of a hand.

d-E Q- O

» The Pan command enables us to move the view to a different position. This function

acts as if you are using a video camera.

6. On your own, use the Zoom and Pan options to reposition the sketch near the

center of the screen.

Modifying the Dimensions of the Sketch

1. Select the dimension that is at

the bottom of the sketch by
double-clicking on the
dimension text.

1. Select this dimension
to modify.
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o " 2. In the Edit Dimension window,
h 4 b the current length of the line is
== displayed. Enter 2.5 to set the
length of the line.
s 25 T —

3. Hit on the Enter key once to
accept the entered value.

» Autodesk Fusion 360 will now update the profile with the new dimension value.

075
4. On your own, repeat the above
Z steps and adjust the dimensions
so that the sketch appears as
shown.
)
3
'd
o
=
i ) e
o E &
250
@ 5. Inthe Ribbon toolbar, click once with the left-
mouse-button on Stop Sketch to end the
CT~  STOP SIJQHZ.H v

Sketch option.

Stop Sketch

Exits the edit sketch state.

Step 3: Completing the Base Solid Feature

Now that the 2D sketch is completed, we will proceed to the next step: create a 3D part
from the 2D profile. Extruding a 2D profile is one of the common methods that can be
used to create 3D parts. We can extrude planar faces along a path. We can also specify a
height value and a tapered angle. In Autodesk Fusion 360, each face has a positive side
and a negative side; the current face we're working on is set as the default positive side.
This positive side identifies the positive extrusion direction and it is referred to as the
face's normal.
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@@ @

HODIEY = 1. Inthe Create toolbar, select the Extrude command

by clicking the left-mouse-button on the icon as
shown.

E% New Component

& Derive

QTEWWE% EEl

ﬁ Revolve

2. Select the 2D sketch we just created by clicking on the closed region as shown.

© EXTRUDE
Start b Profi Plane -

Direction _;Q One Side: A

Select sketch profiles or planar faces to extrude Fyp i -
ent Distance

Operation (] New Body -

[ ] Cancel

3. Inthe Extrude edit box, enter 2.5 as the extrusion distance.

@

A

Distante

4. Click the OK button to proceed with creating
Operation Cﬁ' MNew Body - the 3D part.

— » Note that all dimensions disappeared from the
- % e screen. All parametric definitions are stored in
the database and can be re-displayed.
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Dynamic Rotation of the 3D Object — Free Orbit

The Free Orbit command allows us to:

e Orbit a part or assembly in the graphics window. Rotation can be around the
center mark, free in all directions, or around the X/Y-axes in the 3D-Orbit

display.

e Reposition the part or assembly in the graphics window.
e Display isometric or standard orthographic views of a part or assembly.

The Free Orbit tool is accessible while other tools are active. Autodesk Fusion 360
remembers the last used mode when you exit the Orbit command.

MooF G- =~ E B 1. Click on the Free Orbit icon in the

¢j£> Free Qrbit

";.ﬁp Constrained Orbit

Navigation bar.

» The 3D Orbit display is a circular rim with four handles and a center mark. 3D Orbit
enables us to manipulate the view of 3D objects by clicking and dragging with the

left-mouse-button:

1 Handle |—

P—=

@

\ Center Mark

\ Circular Rim l

Drag with the left-mouse-
button near the center for free
rotation.

Drag on the handles to orbit
around the horizontal or
vertical axes.

Drag on the rim to orbit
about an axis that is
perpendicular to the
displayed view.

Single left-click to align the
center mark of the view.

2. Inside the circular rim, press down the left-mouse-button and drag in an arbitrary
direction; the 3D Orbit command allows us to freely orbit the solid model.

3. Move the cursor near the circular rim and notice the cursor symbol changes to a
single circle. Drag with the left-mouse-button to orbit about an axis that is

perpendicular to the displayed view.
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4. Single left-click near the top-handle to align the selected location to the center
mark in the graphics window.

5. Activate the Constrained Orbit option by clicking on the associated icon as
shown.

Be v Q- 8-@ s\

t@? Free Orbit

&

«» The Constrained Orbit can be used to rotate the model about axes in Model Space,
equivalent to moving the eye position about the model in latitude and longitude.

6. On your own, use the different options described in the above steps and
familiarize yourself with both of the 3D Orbit commands. Reset the display
roughly to the Isometric angle before continuing to the next section.

Note that while in the 3D Orbit mode, a horizontal marker will be displayed next
to the cursor if the cursor is away from the circular rim. This is the exit marker.
Left-clicking once will allow you to exit the 3D Orbit command.

X/
°e

/ Exit marker
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Dynamic Viewing - Quick Keys

We can also use the mouse and the keyboard to access the Dynamic Viewing functions.
Below are the default Autodesk Fusion 360 quick keys settings; we can use other settings

if preferred.
+ Panning — Press and drag with the mouse wheel

Pressing and dragging with the mouse wheel can also reposition the display. This
allows you to reposition the display while maintaining the same scale factor of the

display.

Pan <j MOUSE WHEEL: PRESS & DRAG C>

U

% Zooming — Turning the mouse wheel
Turning the mouse wheel can also adjust the scale of the display. Turning forward

will reduce the scale of the display, making the entities display smaller on the
screen. Turning backward will magnify the scale of the display.

]

Zoom MOUSE WHEEL: TURNING

U

+» 3D Rotation — Shift and the middle-mouse-button

Hold the Shift key down and drag with the middle-mouse-button to orbit the
display.
PN

3D Rotation |Shift | + (1 [MOUSE| ()
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Viewing Tools — Display Control bar and View Cube

-5 Q- O B
\ \ ? \ Display Settings
\ Pan \ Fit/Zoom All
Constrained Orbit
Free Orbit Zoom

/ Q?/ / Zoom Window
€~ 5 \@r S B R B icons
J _

Orbit — In a part or assembly, adds an orbit symbol and cursor to the view. You can orbit
the view planar to the screen around the center mark, around a horizontal or vertical axis,
or around the X and Y axes.

Look At Grid and Snaps

Look At — In a part or assembly, zooms and orbits the model to display the selected
element planar to the screen or a selected edge or line horizontal to the screen. (Not used
in drawings.)

Fit/Zoom All — Adjusts the view so that all items on the screen fit inside the graphics
window.

Zoom Window — Use the cursor to define a region for the view; the defined region is
zoomed to fill the graphics window.

Zoom — Moving upward will reduce the scale of the display, making the entities display
smaller on the screen. Moving downward will magnify the scale of the display.

Pan — This allows you to reposition the display while maintaining the same scale factor
of the display.

Display settings — This panel contains multiple control to the display related settings,
such as Visual Style and Camera.

S / View Cube

. View Cube — The View Cube is a 3D navigation tool that appears at
'.;.;»rf e Ir' the upper right corner of the Fusion 360 main window. The View
W Cube is a clickable interface which allows you to switch between

~ | standard and isometric views.
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The View Cube also provides visual feedback about the current viewpoint of the model
as view changes occur. When the cursor is positioned over the View Cube, it becomes
active and allows you to switch to one of the available preset views, roll the current view,
or change to the Home view of the model.

1.

10.

11.

Move the cursor over the ViewCube and notice the different sides
of the ViewCube become highlighted and can be activated.

Single left-click when the front side is activated as shown. The
current view is set to view the front side.

Move the cursor over the counter-clockwise arrow of the
ViewCube and notice the orbit option becomes highlighted.

Single left-click to activate the counter-clockwise option as
shown. The current view is orbited 90 degrees; we are still
viewing the front side.

Move the cursor over the left arrow of the ViewCube and notice
the orbit option becomes highlighted.

Single left-click to activate the left arrow option as shown. The
current view is now set to view the top side.

Move the cursor over the top edge of the ViewCube and notice
the roll option becomes highlighted.

Single left-click to activate the roll option as shown. The view
will be adjusted to roll 45 degrees.

Move the cursor over one of the corners of the ViewCube and
drag with the left-mouse-button to activate the Free Rotation
option.

Move the cursor over the home icon of the ViewCube and notice
the Home View option becomes highlighted.

Single left-click to activate the Home View option as shown.
The view will be adjusted back to the default isometric view.
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Display Modes

The Visual Style in the Display Settings list has six display-modes showing shaded
renderings and wireframe representations of the model.

Visual Style F  Shaded Ciri+4
Mesh Display 4 Shaded with Hidden Edges Cirl+5
Environment ¥ Shaded with thﬁjgﬁ Only Ctrl+6
Effects » Wireframe Cirls7
Dbject Visibilty 4 Wireframe with Hidden Edges Ctri+g
Camera » Wireframe with Visible Edges Only  Ctrl+9
Ground Plane Offset
@ Enter Full Screen  Cirl+Shift+F ‘
ma Q- BlE- =
% Shaded Solid Modes:
T Shaded Cirl+d The Shaded Solid display modes generate
| I —— e hlgh quality shaded images of the 3D
‘ge object.
» v Shaded with ble Edges Onhy Ctrl+5

r Wireframe Cirl+7

X4

Wireframe Display Modes:

L)

Shaded with Visible Edges Onby Ctri+5 : . .
The Wireframe Image display options

allow the display of the 3D objects using
wolE s sl B Sl the wireframe representation scheme.
Wireframe witi\izible Edges Only  Ctrl+9

Wireframe Ctrl=7

i .

Orthographic vs. Perspective

Besides the above basic display modes, we can also choose orthographic view using the
parallel edges representation scheme or perspective view using the perspective,
nonparallel edges, and representation scheme of the display. Click on the Camera list in
the Display Settings to select the different display options as shown in the figure.

Effects 3
Object Visibility 13
Camera L4 v Orthographic
Ground Plane Ofiset Perspecti
Enter Full Screen  Ctri+Shift+F Perzpective with Ortho Faces
- ElE- -
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Step 4-1: Adding an Extruded Feature

F Autodesk Fusion 360 (Education License)

1. In the Create toolbar, select the
Create Sketch command by
left-clicking once on the icon.

@ untitled* x
HOB- H e o~

e 1 D = @ @

SKETCH v

CREATE™ MoDiI

44 BROWSER Create Sketch

Enters Sketch mode and creates a new sketch on a
selected plane or face.

2. Next to the cursor, the message “Select a plane or planar face” is displayed.
Autodesk Fusion 360 expects us to identify a planar surface where the 2D sketch of
the next feature is to be created. Move the graphics cursor on the 3D part and notice
that Autodesk Fusion 360 will automatically highlight feasible planes and surfaces as
the cursor is on top of the different surfaces. Pick the top horizontal face of the 3D
solid object.

\]\\ 2. Pick the top face of
e the solid model.

» Note that the sketch plane is aligned to the
selected face. Autodesk Fusion 360

s automatically establishes a User-Coordinate-

System (UCS) and records its location with

respect to the part on which it was created.

e Next, we will create and profile another sketch, a rectangle, which will be used to
create another extrusion feature that will be added to the existing solid object.

F Autodesk Fusion 360 (Education License)

I P untitied- N - 3. Select the Line command by clicking once
with the left-mouse-button on the icon in

B B H -~ the Sketch tab on the Ribbon.
oot~ K4 F@ = [ d
SKETCH * CREATE|
+4 BROWSER Line f_l:]

Creates lines and arcs.
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4. Create a sketch, starting at the top left corner of the solid model, with six line
segments perpendicular/parallel to the solid model as shown below.

R N >
>
2y
1 D RepeatLine | 5. Inside the graphics window, click once with
: ' T g— the right-mouse-button to display the option
S menu. Select Cancel (ESC) in the pop-up
o 2 menu to end the Line command.
Hl:rl_e |
Sketch ¥ |
Prolect flnclude " 6. Select the Sketch Dimension command in the
Mesh > Sketch toolbar. The Sketch Dimension command
m allows us to quickly create and modify dimensions.
€3 Stop Sketch You can also hit [D] on the keyboard to activate this
command.

7. Create the four size dimensions, set values to 2.5 & .75, to describe the size of the

sketch as shown.
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[ Repeat Sketen Dimg - ¢ - pside the graphics window, click once with the right-
Detete [T} | (A mouse-button to display the option menu. Select Cancel
in the pop-up menu to end the Sketch Dimension
m_ command.
Move/Copy +E¢ | @
Sketch |

command.

CT~

9. Inthe Ribbon area, select Stop Sketch to end the Sketch
STOP SE TCH ™

Stop Sketch

Exits the edit ske’

g QT @ rE 10. In the Create toolbar, select the Extrude command by left-

clicking on the icon.
CREATE ¥ Mo

Extrude (&)
Adds depth to a close

11. Select inside the 2D sketch we just created as the region to extrude.

| select sketch profiles or planar faces to extrud

12. Move the cursor on top of the arrow; notice the
dashed line appears as shown. We can drag the
arrow, with the left mouse button, to set the
extrusion distance and direction.

Select sketch p
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13. Drag the arrow downward, with the left mouse button, and set the extrusion

distance to -2.5 as shown.

profiles or planar faces tg

@ EXTRUDE
Profile
Start
Direction
Extent
Distance

Taper Angle

Operation

k 1 zelected A

|-> Profile Plane A
h One Side v
H Distance v
-2.500 in -
0 deg -
. Jain A

q Cancel

0.000 in

-25000in | -

14. In the Extrude pop-up window, confirm the
settings are set to Join and -2.50 in as shown.

15. Click on the OK button to proceed with creating
the extruded feature.
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Step 4-2: Adding a Cut Feature

Next, we will create and profile a circle, which will be used to create a cut feature that
will be added to the existing solid object.

F Autodesk Fusion 360 (Education License)

1. In the Create toolbar, select the
Create Sketch command by
left-clicking once on the icon.

@ untitlea* x
HOE- H e o~

e G D @& O

SKETCH v CREATE ~ MoDiI

44 BROWSER Create Sketch

Enters Sketch mode and creates a new sketch on a

selected plane or face.

2. Pick the top horizontal face of the 3D
solid model as shown.

» Note that the sketch plane is aligned
to the selected face. Autodesk Fusion
360 automatically establishes a User-
Coordinate-System (UCS) and
records its location with respect to the
part on which it was created.

@ ) ] QI @ Q % 3. Select the Center Diameter circle
SIELES A e command by clicking once with the left-

L] Create Sketch I mouse-button on the icon in the Sketch
.2 Line L toolbar as shown.

Rectangle »

Circle P () Center Diameter Circle €}

Are q[e) > PoitRircle

Palygon " ¢ 3-point circle

4. Create a circle of arbitrary size on the top
face of the solid model as shown.
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5. On your own, create and modify the dimensions of the sketch as shown in the

figure.
B
@o7s
0.75
[ Repeat Sketch Dims
*:M ~ Dekete [} | ] 6. Inside the graphics window, click once with the right-
i S mouse-button to display the option menu. Select Cancel

in the pop-up menu to end the Sketch Dimension

- o
. Move/Copy +o+ | @ command.

Sketch W |

= mouse-button to display the option menu. Select Finish

%’ A 7. Inside the graphics window, click once with the right-
e 2D Sketch in the pop-up menu to end the Sketch option.

Stop Sketch
Exits the edit ske

8. In the Create toolbar, select the Extrude command by left-
clicking on the icon.

Extrude (&)

Adds depth to a close

® EXTRUDE 9. In the Extrude pop-up control, the Profile button is
- ﬂ pressed down; Autodesk Fusion 360 expects us to
identify the profile to be extruded.
Start |-' Protile Plane
i Ba o cus




Parametric Modeling Fundamentals 2-29

10. Click on the inside of the sketched
circle to define the extrude profile
as shown.

Taper Angle 0 deg

Operation I New Body

[ Mew A

11. Select the CUT option in the feature
option list to set the extrusion operation
to Cut.

12. Move the cursor on top of the
arrow; notice the dashed line
appears.

13. Drag the arrow downward, with
the left mouse button, to set the
extrusion direction.

Direction Sh One Side

Extent

Distance H Distance

Taper Angle _:I:IJ To Object
= Al

Operation E Cut vu

14. Set the Extent option to Through All as
shown. The All option instructs the software
to calculate the extrusion distance and assures

the created feature will always cut through
the full length of the model.



2-30 Parametric Modeling with Autodesk Fusion 360

Operation E Cut r

(] OPB Cancel

» Objects To Cut 15. Click on the OK button to proceed with
creating the extruded feature.

Step 4-3: Adding another Cut Feature

Next, we will create and profile a triangle, which will be used to create a cut feature that
will be added to the existing solid object.

F Autodesk Fusion 360 (Education License)

@ untitled* x

B- H «- -

- o= IR @

SKETCH ™ CREATE™ KMoDI

Create Sketch

Enters Sketch mode and creates a new sketch on a
selected plane or face.

2. Pick the vertical face of the 3D solid model
next to the horizontal section as shown.

In the 3D Model tab select the
Create Sketch command by left-
clicking once on the icon.
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= k- -
b H 3. Select the Line command by
7 clicking once with the left-mouse-
|| MODEL ~ '—:& g @ ' button on the icon in the Sketch

tab.

+4 BROWSER Line (I}
Creates lines and arcs.

FECE S (Unsaved)

4. Start at the upper left corner and create three
line segments to form a small triangle as shown.

1.00

]

|

5. On your own, create and modify
the two dimensions of the sketch
as shown in the figure. (Hint:
create the angle dimension by
selecting the two adjacent lines
and place the angular dimension
inside the desired quadrant.)

=)

™ 6. Inside the graphics window, click once with the right-

/ : : . .
Delete [ | mouse-button to display the option menu. Select Cancel
in the pop-up menu to end the Sketch Dimension
B command.
": Move/Copy +3+ |

-:P-'

Sketch w |

7. In the ribbon toolbar area, select Stop Sketch to end the
Sketch option.

T STOP SKETCH ™
Stop Sketch
‘ Exits the edit ske
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D@ (

CREATE™

Mo

Extrude (&)

Adds depth to a close

8. In the Ribbon toolbar, select the Extrude command by left-

clicking the icon.

9. Click on the inside of the sketched
circle to define the extrude profile as

shown.
profiles or planar faces to g
TOPsT TG Ty
Ooera & tewe 10. Select the CUT option in the feature option
e - . . .
pereer list to set the extrusion operation to Cut.
. Join
i) [ Cut :
|‘E‘| Int&rs%ct
E’ﬁ MNew Body
Direction M One Side r
Extent 11. Set the Extents option to To Object as
_ | Distance shown. The To Object option instructs the
Distance . software to calculate the extrusion distance
et al L O*I'S - and assures the created feature will always
ot Al cut through the proper length of the model.
Mneratinn J:L Cut h
Extent + | To Object - o .
e Note the Select icon is activated and Fusion
Object 360 expects us to select an object to set the
: termination of the extrude feature.
O ffzet 0.000 in *
Taper Angle: 0 deg -
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12. On your own, use the
dynamic rotate function and
select the back surface as
shown.

0 ole workplane, vertex, faces or by
@ EXTRUDE
Profile [s 1 selected X
Start b Profie Plane -
Directon By One Side - 13. On your own, confirm the settings in the extrude
Extent ] To Object . dialog box are as shown and click on the OK button
to proceed with creating the extruded feature.
Obiject 1 selected [k
Distance (Ta) -
Chain Faces j
Offset 0.000 in -
Taper Angle 0 deg -
Operation E Cut v
P Objects To Cut
i ] q Cancel




2-34 Parametric Modeling with Autodesk Fusion 360

Save the Model

P untitied*

F Autodesk Fusion 360 (Education License)

1. Select Save in the Quick Access toolbar, or you can
also use the “Ctrl-S” combination (hold down the

HIEE -~ - “Ctrl” key and hit the “S” key once) to save the part.

MNew Design

New Drawing

+4 BA Recover Documents (2)

Open... Ctrl+0

Parametric Modeling > © master » Chapter 2

4 Upload...
Save Cirl+5
Save as Ik
- 2. Expand the option list by clicking on the down arrow as
% shown.
3. Select the Parametric Modeling Project by
PROJECT clicking once with the left mouse button.
» Demo Project 4. Click New Folder to create a new
» Parametric I"-'mlging subfolder.
» Randy's First Project
Mew Folder
NAME - OWHNER L
Ml Chapter | Randy Shih 'l 5. Enter Chapter2 as the new folder
-| Chapter 2 name as shown.
Name: 6. Double-click on the Chapter2
Adjuster folder to open it.
7. In the file name editor box, enter
_ Adjuster as the file name.
Location:

8. Click on the Save button to save
the file.
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Review Questions:

1. What is the first thing we should set up in Autodesk Fusion 360 when creating a new
model?

2. Describe the general parametric modeling procedure.

3. Describe the general guidelines in creating Rough Sketches.

4. List two of the geometric constraint symbols used by Autodesk Fusion 360.
5. What was the first feature we created in this lesson?

6. How many solid features were created in the tutorial?

7. How do we control the size of a feature in parametric modeling?

8. Which command was used to create the last cut feature in the tutorial? How many
dimensions do we need to fully describe the cut feature?

9. List and describe three differences between parametric modeling and traditional 2D
Computer Aided Drafting techniques.
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Exercises: Create and save the exercises in the Chapter2 folder.

(All dimensions are in inches.)

1. Inclined Support (Thickness: .5)

1.0

1n

2.0

2. Spacer Plate (Thickness: .125)

5.3

30

1.3

B3

1]

20

23
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3. Positioning Stop

4. Guide Block
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5. Slider Block

6. Coupler

4 %d200

@12 .00

100 =

1

@eon — -

= 1.00

e

1600






